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The Vaal University of Technology Reference Manual: APA Style 

Introduction 

This manual is designed to help university students correctly format references in APA style. 

Consistent referencing is essential for academic integrity and avoiding plagiarism. 

Referencing is a fundamental aspect of academic writing. It acknowledges the original sources of 

ideas, theories, and research findings, giving credit to the authors and researchers who have 

contributed to the field. Proper referencing allows readers to trace the origin of information, 

facilitating further research and verification. It also demonstrates the writer’s engagement with 

existing literature and ability to integrate external knowledge into their work. This not only supports 

the credibility and reliability of the academic work but also upholds the ethical standards of 

scholarship. 

The APA (American Psychological Association) style, particularly the 5th edition, is an ideal 

referencing style for various reasons. First, it is widely recognised and adopted across many 

disciplines, particularly in the social sciences, education, and psychology. This widespread 

acceptance ensures that students and researchers using APA style are following a standardised and 

respected format, which enhances the clarity and professionalism of their work. The APA 7th edition 

provides clear guidelines for a wide range of source types, including books, journal articles, websites, 

and more, making it a versatile choice for academic writing. 

Moreover, the APA 7th edition emphasises precision and uniformity in referencing. Its structured 

approach to citations and references helps maintain consistency throughout a document, which is 

crucial for readability and coherence. By adhering to APA style, students can avoid common pitfalls 

of referencing, such as incorrect attribution or incomplete citations. The style’s detailed rules for in-

text citations and reference lists ensure that all necessary information is included, enabling readers 

to easily locate the original sources. This not only supports academic integrity but also enhances the 

overall quality of academic writing, making APA 7th edition a reliable and effective choice for 

students and researchers alike. 

For students and professionals in the sciences and engineering, the APA 7th edition offers significant 

advantages. Scientific and technical writing often involves the citation of diverse types of sources, 

including journal articles, technical reports, patents, and conference proceedings. The comprehensive 

guidelines provided by the APA 7th edition ensure that these sources are cited accurately and 

consistently, which is essential for maintaining the integrity of scientific communication. 

Additionally, the APA style's focus on clarity and brevity helps in presenting complex information in 

a clear and accessible manner, which is critical in the fields of science and engineering. By adhering 

to the APA 7th edition, researchers can ensure their work is presented professionally and is easily 

understandable by peers and reviewers. 
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What is Plagiarism? 

Plagiarism means: “to take somebody else’s ideas or words and use them as if they were one’s 

own” (Oxford Advanced Learner’s Dictionary 1995:880). Another author’s work must always be 

acknowledged. 

 

When to Reference? 

Referencing should be done when you: 

 Quote another person’s exact words 

 Copy any figures, tables or structures, pictures 

 Paraphrase or convert someone else’s ideas into your own words 

 Summarise or give a brief account of another person’s work. 
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DEFINITIONS 

Author is any person or entity responsible for a particular piece of work. This includes editors, 

compilers, composers, persons interviewed, companies etc. 

Bibliography list of sources, arranged in alphabetical order, that have been consulted to compile 

your assignment, project, etc., but which are not necessarily cited in the written document. Note: In 

academic writing, one usually submits a “Reference list” rather than a “Bibliography”. 

Citation is a written reference to a specific work or portion of a work. 

Citing to mention, quote by way of an example, or bring forward as support, illustration, proof or 

authority. 

Copyright is a legal right that gives the author of an original work exclusive rights for a certain time 

period in relation to that work, including its publication, distribution and adaptation. 

Corporate author is an organisation or group of persons (associations, institutions, companies, 

etc.) that is identified by a corporate or group name and acts as an entity responsible for a particular 

body or piece of work, i.e. Vaal University of Technology (VUT). 

Direct quotation is a phrase or, paragraph, or part of the original text which has been repeated in 

exactly the same way as the original piece of work. 

In-text referencing is the insertion of brief references in the appropriate places in the text to 

sources that are being cited in one's work. 

Journal, serials or periodical sources which are published periodically, i.e. weekly, monthly, 

yearly, etc. Examples are newspapers, magazines, academic journals, and yearbooks. 

Online database collection of information arranged in a systematic way to make the search easy 

and fast. The University subscribes to different databases, such as EBSCOhost, ProQuest, Sabinet, 

etc., in order to meet research requirements. 

Published source any information source, whether in print or electronic format, that is made 

available to the public. 

Unpublished source any information source that has not been published, most of the reports, 

lecture notes, study guides and pamphlets fall on this category. 

Reference list an alphabetical list (by author’s surname or corporate author) of books, articles, 

websites or any other sources, that have been consulted during the writing of your assignments, 

projects, research papers, dissertation, thesis, etc. 

Source a person or group, a book, an article, a thesis, journal or any other work that provides 

information. 

. 
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SOURCE REFERENCING RULES 

 

 Editions are only noted from the 2nd edition onwards. 

 

 If there are one to two authors, all authors have to be cited and should be listed in the order that 

they appear. 

 

 If there are more than two authors, use the surname of the first author, followed by ‘et al.’ in 

your in-text referencing, which means ‘and others’, but list them in your bibliographic list. 

 

 Where the author is unknown, the title of the work. could be used, followed by the date of 

publication. 

 

 Make every effort to establish the authorship if you intend to use your work in an academic 

submission. 

 

 Secondary referencing is used in a book or journal article where the author cites facts or 

information cited in research done by someone else. This is regarded as a secondary source as the 

researcher has not consulted the original source; however, every attempt should be made to cite the 

original/primary source. 

 

 For unpublished material, the title is not to be written in italics or underlined if one has hand-

written it. 

 

 The use of direct quotations “ ” is discouraged unless you have taken the exact words of an 

author. 

 

 The bibliographic list at the end of your document needs to be strictly alphabetical (the example is 

provided at the end of this document). 

 

 Consistency is the most vital element of referencing. 
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***ABBREVIATIONS*** 

Terms Abbreviations 

Appendix app. 

Chapter chap. 

Column col. 

Compiler comp. 

Compilers comp(s). 

Edition ed. 

Editions ed(s). 

Editor ed. 

Editors ed(s). 

First edition, second edition, etc. 1st ed., 2nd ed., etc. 

No date n.d. 

No place, no publisher, no page n.p. 

Number no. 

Page p. 

Paragraph par. 

Part pt. 

Revised rev. 

Revised edition rev. ed. 

Supplement suppl. 

Translated/translator transl. 

Volume vol. 

Volumes Vol(s). 

Getting Started with APA Style 

General APA Formatting Rules 

• Font: Times New Roman, 12-point 

Below is a step-by-step guide on how to set up these formatting rules in a Word document. 

Font: Times New Roman, 12-point 

1. Open your Word document. 
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2. Select all text: Press Ctrl + A (Windows) or Command + A (Mac) to highlight the entire 

document. 

3. Choose the font: 

o Go to the Home tab. 

o In the Font group, click on the font dropdown menu. 

o Select Times New Roman. 

4. Set the font size: 

o In the same Font group, click on the font size dropdown menu. 

o Select 12. 

Margins: 1 inch on all sides 

1. Go to the Layout tab (sometimes labelled Page Layout). 

2. Click on Margins: 

o In the Page Setup group, click the Margins button. 

3. Select Normal: 

o Choose the Normal option, which sets the margins to 1 inch on all sides. 

Line Spacing: Double-spaced 

1. Select all text: 

o Press Ctrl + A (Windows) or Command + A (Mac) to highlight the entire 

document. 

2. Set line spacing: 

o Go to the Home tab. 

o In the Paragraph group, click the small arrow in the bottom right corner to open 

the Paragraph dialogue box. 

 

3. Adjust line spacing: 

o In the Spacing section, find the Line spacing dropdown menu. 

o Select Double. 

o Ensure that Before and After spacing are set to 0 pt. 

4. Apply changes: 

o Click OK to apply the double spacing. 
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Indentation: 0.5 inch for the first line of every paragraph 

1. Select all text: 

o Press Ctrl + A (Windows) or Command + A (Mac) to highlight the entire 

document. 

2. Open the Paragraph dialog box: 

o Go to the Home tab. 

o In the Paragraph group, click the small arrow in the bottom right corner. 

3. Set indentation: 

o In the Indentation section, find the Special dropdown menu. 

o Select the First line. 

o In the By field next to it, ensure it says 0.5 inches. 

4. Apply changes: 

o Click OK to apply the first-line indentation. 

In-Text Citations 

Citations will always include the first word(s) of your reference page entry, usually the name 

of the person(s) or group considered the “author” of the work. Direct quotations require page 

or paragraph numbers, but paraphrases usually do not. Both can be cited narratively 

(author’s name as part of the sentence) or parenthetically (author’s name in parentheses after 

the sentence). 

 

DIRECT QUOTATION 

 NARRATIVE CITATION  PARENTHETICAL CITATION 

One author Botha (2020) contended that 

“imagination is crucial” (p. 41). 

Clearly, “imagination is crucial” 

(Botha, 2020, p. 41). 

Two authors According to Botha & Rose 

(2022), “imagination is crucial” 

(pp. 41-43).  

It is true that “imagination is 

crucial” (Botha & Rose, 2022, pp. 

41-43). 

Three + 

authors 

“Imagination is crucial”, Botha et 

al. (2022) reflected (para. 10).  

However, “imagination is crucial”. 

(Botha et al. 2022, para. 10). 

Group author, 

first reference 

The Council of Higher Education 

(CHE, 2022) has insisted that 

“imagination is crucial” (p. 15). 

Perhaps “imagination is crucial 

(The Council of Higher Education 

[CHE], 2022, p. 15). 

Group author, 

late reference 

(CHE) has insisted that 

“imagination is crucial” (para. 

15). 

Perhaps “imagination is crucial 

(CHE], 2022, p. 15). 

Author 

unknown 

The author of “Bold Minds” 

(2021) noted that “imagination is 

crucial” (p. 14). 

One article (2021) claimed that 

“imagination is crucial” (“Bold”, 

2021, p. 14). 
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PARAPHRASE 

 NARRATIVE CITATION PARENTHETICAL CITATION 

One author Smith (2022) argued that students 

must develop imagination. 

Students must develop imagination 

(Smith, 2022).  

Two authors Smith and Langa (2021) believe 

that students must develop 

imagination  

Students must develop imagination 

(Smith & Langa, 2022). 

Three + 

authors 

Students must develop 

imagination, according to Smith 

et al. (2022). 

Students must develop imagination 

(Smith et al., 2022). 

Group author, 

first reference 

According to the Council of 

Higher Education (CHE, 2021), 

students must develop 

imagination. 

Students must develop imagination 

(Council of Higher Education 

[CHE], 2021). 

Group author, 

late reference 

According to the CHE (2021), 

students must develop 

imagination 

Students must develop imagination 

(CHE, 2021). 

Author 

unknown 

In “Bold Minds (2022), the author 

suggested that students must 

develop imagination. 

Students must develop imagination 

(“Bold”, 2022). 

 

Basic In-Text Citation Format 

• Single Author: (Author, Year) 

When referencing a work by a single author, you include the author's last name followed 

by the year of publication in parentheses. This format helps readers quickly identify the 

source of the information you are presenting. For example, if you are citing a book 

written by John Smith in 2020, your in-text citation would look like this: (Smith, 2020). 

If you mention the author in your sentence, include only the year in parentheses. For 

instance, you might write: 

"Effective referencing is crucial for academic integrity" (Smith, 2020). Alternatively, if 

incorporating the author's name into the text, Smith (2020) argues that "effective 

referencing is crucial for academic integrity." 

• Two Authors: (Author1 & Author2, Year) 

For a source written by two authors, both last names should be included in the in-text 

citation, separated by an ampersand (&), followed by the year of publication. This 

format provides clear credit to both authors involved in the work. For example, if you 

are citing a paper by John Smith and Mary Jones from 2020, the citation would be 

formatted as follows: (Smith & Jones, 2020). If you mention the authors in your 

sentence, use "and" instead of the ampersand. For instance: 

"Proper citation techniques are essential in academic writing" (Smith & Jones, 2020). 

Alternatively, within the text, Smith and Jones (2020) highlight the importance of 

"proper citation techniques in academic writing." 
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• Three or More Authors: (Author1 et al., Year) 

When citing a source with three or more authors, only the first author's last name is 

listed, followed by "et al." (which means "and others") and the year of publication. This 

abbreviation helps keep citations concise without omitting credit to the other authors. 

For example, if a study conducted by John Smith, Mary Jones, and James Brown were 

published in 2020, your in-text citation would be: (Smith et al., 2020). When 

referencing the authors within your sentence, it would be formatted similarly. For 

instance: 

"Consistent referencing practices enhance the credibility of academic work" (Smith et 

al., 2020). Alternatively, within the text, Smith et al. (2020) found that "consistent 

referencing practices enhance the credibility of academic work." 

 

Specific In-Text Citation Examples 

• Direct Quote: "Quote" (Author, Year, p. Page Number) 

When using a direct quote from a source, it is important to include the exact wording 

within quotation marks, followed by an in-text citation that includes the author's last 

name, the year of publication, and the page number where the quote can be found. This 

format provides precise information about the source and location of the quoted 

material, allowing readers to easily find the original text. For example, if you are 

quoting from a book by John Smith, published in 2020, you might write: 

In discussing the importance of proper referencing, Smith stated, "APA style is easy to 

learn" (Smith, 2020, p. 15). This quote highlights the accessibility of APA guidelines 

and underscores the importance of mastering citation techniques for academic success. 

Example: "APA style is easy to learn" (Smith, 2020, p. 15). 

And also 

In discussing the role of technology in modern education, it has been noted that "digital 

tools can enhance learning experiences significantly" (Jones, 2019, p. 45). This 

statement emphasises the potential for technological integration to improve educational 

outcomes, suggesting that teachers should consider incorporating more digital 

resources into their curricula. 

• Paraphrasing: (Author, Year) 

Paraphrasing involves rephrasing information from a source in your own words. When 

paraphrasing, you still need to provide an in-text citation to credit the original author. 

This citation includes the author's last name and the year of publication. Paraphrasing 

allows you to incorporate ideas from a source while maintaining your own writing style 

and demonstrating your understanding of the material. For example, if you are 

paraphrasing a concept from John Smith's 2020 book, you might write: 
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According to Smith (2020), the principles of APA style are designed to be 

straightforward and user-friendly, making it easier for students to accurately cite their 

sources. This approach helps ensure that academic work is properly attributed and free 

from plagiarism. 

And Also 

Research indicates that integrating digital tools into the classroom can greatly improve 

the learning experience for students (Jones, 2019). According to Jones, the use of 

technology in education allows for more interactive and engaging lessons, which can 

lead to better student retention and understanding of the material. This perspective 

highlights the importance of embracing technological advancements to enhance 

educational practices. 

Citing Multiple Works 

• Same Author, Multiple Works: (Author, Year1, Year2) 

o Example: (Smith, 2020, 2021) 

• Same Author, Multiple Works in the Same Year: (Author, Yeara, Yearb) 

o Example: (Smith, 2020a, 2020b) 

• In Reference List: 

o Smith, J. (2020a). Title of first work. Publisher. 

o Smith, J. (2020b). Title of second work. Publisher. 

• Different Authors, Separate Citations: (Author1, Year; Author2, Year) 

o Example: (Smith, 2020; Jones, 2021) 

Personal Communications 

In APA style, personal communications such as interviews, letters, emails, or private messages 

are cited only in the text and not included in the reference list. This is because personal 

communications do not provide recoverable data that can be accessed by others. Here is how 

you can properly cite personal communications in-text: 

• Initials and Last Name: Provide the initials and last name of the person you 

communicated with. 

• Personal Communication: Clearly state that it is a personal communication. 

• Exact Date: Include the full date of the communication (Month, Day, Year). 

Example: 

1. Within the text: 

According to J. A. Smith (personal communication, March 15, 2020), effective referencing is 

crucial for academic integrity. 

2. Parenthetical citation: 

Effective referencing is crucial for academic integrity (J. A. Smith, personal communication, 

March 15, 2020). 
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Interviews 

For an unpublished interview that you conducted, treat it as personal communication and cite 

it in the same way. 

Example: 

1. Within the text: 

During the interview, M. Brown (personal communication, April 22, 2021) emphasised the 

importance of practical experience in the engineering field. 

2. Parenthetical citation: 

Practical experience is vital in the engineering field (M. Brown, personal communication, April 

22, 2021). 

 

 

 

 

Using Reference Managers 

Reference managers are tools that help you organise and cite your sources efficiently. They can 

save you time and ensure accuracy in your citations and references. Here are some popular 

reference managers and how to use them effectively: 

Mendeley 

Getting Started 

1. Download and Install: 

o Visit Mendeley to download and install the software. 

2. Create an Account: 

o Sign up for a free account to sync your library across devices. 

3. Add References: 

o Use the “Add Files” button or drag and drop PDFs into the Mendeley library. 

o You can also use the Mendeley Web Importer to add references directly from 

your browser. 

Using Mendeley for APA Style 

1. Insert In-Text Citations: 

o Install the Mendeley Word plugin from the Mendeley Desktop. You can find it 

under the "Tools" menu and then "Install MS Word Plugin." 
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o In your Word document, use the “Insert Citation” button in the Mendeley plugin 

to add citations. 

2. Generate a Bibliography: 

o Use the “Insert Bibliography” button in the Mendeley plugin to generate your 

reference list in APA style. 

3. YouTube Tutorial: How to use Mendeley for reference management 

Endnote 

Getting Started 

1. Download and Install: 

o Visit Endnote to download and install the software. 

2. Create an Account: 

o Sign up for an Endnote account to access cloud storage and sync your 

references. 

3. Add References: 

o Import references via “File” > “Import” or use the “Capture Reference” tool in 

your browser. 

Using Endnote for APA Style 

1. Insert In-Text Citations: 

o Install the Endnote Word plugin. You can find it in the Endnote software under 

"Customizer" or "Configure Endnote" and then "Cite While You Write." 

o In your Word document, use the “Insert Citation” button in the Endnote toolbar 

to add citations. 

2. Generate a Bibliography: 

o Use the “Update Citations and Bibliography” button in the Endnote toolbar to 

create your reference list in APA style. 

3. YouTube Tutorial: EndNote Tutorial: An Introduction 

Zotero 

Getting Started 

1. Download and Install: 

o Visit Zotero to download and install the software. 

2. Install Browser Connector: 

o Install the Zotero browser connector for easy reference importing. You can find 

it on the same download page. 

https://www.youtube.com/watch?v=Se_tCqF9OE8
https://www.youtube.com/watch?v=lLZ2PONTQnQ
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3. Create an Account: 

o Sign up for a Zotero account to sync your library and access cloud storage. 

Using Zotero for APA Style 

1. Insert In-Text Citations: 

o Install the Zotero Word plugin. It is included with the main Zotero software, and 

it will automatically be installed if you have Word installed on your computer. 

o In your Word document, use the “Add/Edit Citation” button in the Zotero plugin 

to add citations. 

2. Generate a Bibliography: 

o Use the “Add/Edit Bibliography” button in the Zotero plugin to create your 

reference list in APA style. 

3. YouTube Tutorial: Zotero Tutorial for Beginners 

 

 

 

Tips for Using Reference Managers 

• Organize Your References: 

o Use folders, tags, or groups to keep your references organized. 

• Check for Accuracy: 

o Always double-check imported references for completeness and accuracy. 

• Back Up Your Library: 

o Regularly back up your reference library to avoid data loss. 

Using reference managers effectively can streamline your research process and ensure that your 

citations and references are accurate and consistent with APA style guidelines. 

 

 

 

 

 

 

 

https://www.youtube.com/watch?v=1hS8GuhRLTk
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Reference List Format 

General Rules for Reference Lists 

• Order: Alphabetical by the first author's last name 

• Hanging Indent: Each reference should have a hanging indent of 0.5 inch 

• Double-Spaced: The entire reference list should be double-spaced 

• In APA 5th edition style, if a work has up to six authors, all authors' names should be 

included in the reference list. If a work has more than six authors, the first six authors 

are listed, followed by "et al." to indicate that there are additional authors not listed. 

Here is how it works: 

Up to Six Authors 

Format: 

• Author, A. A., Author, B. B., Author, C. C., Author, D. D., Author, E. E., & 

Author, F. F. (Year). Title of the article. Title of the Journal, volume number 

(issue number), pages. DOI/URL 

Example: 

• Smith, J., Jones, M., Brown, T., Johnson, A., White, R., & Green, L. (2020). 

Study on APA referencing. Journal of Academic Writing, 12(3), 45-67. 

https://doi.org/10.1234/jaw.v12i3.567 
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More Than Six Authors 

Format: 

• Author, A. A., Author, B. B., Author, C. C., Author, D. D., Author, E. E., Author, 

F. F., et al. (Year). Title of the article. Title of the Journal, volume number(issue 

number), pages. DOI/URL 

Example: 

• Smith, J., Jones, M., Brown, T., Johnson, A., White, R., Green, L., et al. (2020). 

A comprehensive study on APA referencing. Journal of Academic Writing, 

12(3), 45-67. https://doi.org/10.1234/jaw.v12i3.567 

By following this format, you ensure that your references are properly formatted 

according to APA 5th edition guidelines while managing long lists of authors efficiently. 

Books 

• Format: Author, A. A. (Year). Title of book. Publisher. 

o Example: Smith, J. (2020). Understanding APA Style. Academic Press. 

Journal Articles 

• Format: Author, A. A., Author, B. B., & Author, C. C. (Year). Title of article. Title of 

Periodical, volume number(issue number), pages. https://doi.org/xx.xxx/yyyy 

o Example: Smith, J., & Jones, M. (2020). APA referencing simplified. Journal of 

Academic Writing, 12(3), 45-67. https://doi.org/10.1234/jaw.v12i3.567 

Websites 

• Format: Author, A. A. (Year, Month, Date). Title of web page. Site Name. URL 

o Example: Smith, J. (2020, January 15). APA style guidelines. Writing Center. 

https://www.writingcenter.org/apa-style 

Book Chapters 

• Format: Author, A. A. (Year). Title of chapter. In A. Editor, B. Editor, & C. Editor 

(Eds.), Title of book (pp. pages). Publisher. 

o Example: Smith, J. (2020). Referencing in APA. In R. Brown & T. Green (Eds.), 

The Handbook of academic writing (pp. 123-145). Academic Press. 

Conference Papers 

• Format: Author, A. A. (Year). Title of paper. In E. E. Editor (Ed.), Proceedings of the 

Conference (pp. pages). Publisher. URL 

o Example: Smith, J. (2020). APA referencing in academic papers. In R. White 

(Ed.), Proceedings of the International Conference on Academic Writing (pp. 

234-245). Academic Press. https://www.conference.org/papers/apa2020 
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Reports 

• Format: Author, A. A. (Year). Title of report (Report No. 123). Publisher. URL 

o Example: Smith, J. (2020). Annual report on APA referencing (Report No. 123). 

Writing Center. https://www.writingcenter.org/reports/annual2020 

Theses and Dissertations 

• Format: Author, A. A. (Year). Title of thesis or dissertation (Publication No. 12345) 

[Doctoral dissertation, University Name]. Database Name. 

o Example: Smith, J. (2020). An analysis of APA referencing styles (Publication 

No. 12345) [Doctoral dissertation, University of Education]. ProQuest 

Dissertations & Theses Global. 

Videos 

• Format: Author, A. A. [Username]. (Year, Month, Date). Title of video [Video]. 

Platform. URL 

o Example: Johnson, L. [LJohnson]. (2020, March 5). How to reference in APA 

style [Video]. YouTube. https://www.youtube.com/watch?v=abcd1234 

Pictures/Images 

• Format: Author, A. A. (Year). Title of image [Image]. Website. URL 

o Example: Smith, J. (2020). Sunset over the mountains [Image]. Unsplash. 

https://www.unsplash.com/photos/abcd1234 

Statutes 

• Format: Name of Act, Title Source § Section Number (Year). URL 

o Example: Clean Air Act, 42 U.S.C. § 7401 (1970). https://www.epa.gov/laws-

regulations/summary-clean-air-act 

Patents 

• Format: Inventor, A. A. (Year). Title of patent (Patent No. 1234567). URL 

o Example: Doe, J. (2020). Method for referencing styles (Patent No. 1234567). 

https://patents.google.com/patent/US1234567 

Data Sets 

• Format: Author, A. A. (Year). Title of data set [Data set]. Publisher. URL 

o Example: National Center for Education Statistics. (2020). College enrollment 

rates [Data set]. https://nces.ed.gov/data/college_enrollment 

Software 

• Format: Author, A. A. (Year). Title of software (Version number) [Computer software]. 

Publisher. URL 

https://www.youtube.com/watch?v=abcd1234
https://www.epa.gov/laws-regulations/summary-clean-air-act
https://www.epa.gov/laws-regulations/summary-clean-air-act
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o Example: Smith, J. (2020). Referencing software (Version 2.0) [Computer 

software]. Academic Software. https://www.academicsoftware.com/download 

Government Documents 

• Format: Government Agency. (Year). Title of document (Publication No. 123). 

Publisher. URL 

o Example: U.S. Department of Health and Human Services. (2020). Health 

statistics report (Publication No. 123). Government Printing Office. 

https://www.hhs.gov/reports/health2020 

Online Forums and Discussion Boards 

• Format: Author, A. A. [Username]. (Year, Month, Date). Title of post [Online forum 

post]. Platform. URL 

o Example: Smith, J. [JSmith]. (2020, May 10). Questions about APA referencing 

[Online forum post]. Reddit. 

https://www.reddit.com/r/APAstyle/comments/abcd1234 

Podcasts 

• Format: Host, A. A. (Host). (Year, Month, Date). Title of episode (No. episode number) 

[Audio podcast episode]. In Title of podcast. Production Company. URL 

o Example: Doe, J. (Host). (2020, January 1). Understanding APA citations (No. 

10) [Audio podcast episode]. In Academic Podcasts. Podcast Network. 

https://www.podcastnetwork.com/episodes/10 

Interviews 

• Format: Interviewee, A. A. (Year, Month, Date). Title of the interview [Interview]. 

Interviewer: B. B. URL 

o Example: Johnson, L. (2020, June 15). Referencing in academic writing 

[Interview]. Interviewer: M. Smith. https://www.interviews.com/abc123 

Newspaper Articles 

• Format: Author, A. A. (Year, Month, Date). Title of article. Title of Newspaper, p. Page 

Number. URL 

o Example: Brown, T. (2020, July 10). New APA guidelines released. The Daily 

News, p. A1. https://www.dailynews.com/apa-guidelines 

 

Common Issues and Troubleshooting 

Common Errors 

• Incorrect Author Order: Ensure all authors are listed in the order they appear in the 

source. 

https://www.reddit.com/r/APAstyle/comments/abcd1234
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• Missing Information: Double-check for missing publication years, page numbers, and 

URLs. 

• Formatting Issues: Ensure proper use of italics, capitalisation, and punctuation. 

Tips for Accuracy 

• Double-check sources: Verify all citation details against the original source. 

• Use APA Tools: Utilize online APA citation tools and guides for additional assistance. 

Additional Resources 

• APA Style Official Website 

• Purdue OWL APA Guide 

https://apastyle.apa.org/

